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Branch Transformation Toolkit installation guide

This installation guide describes the hardware and software requirements of IBM®
Branch Transformation Toolkit for WebSphere® Studio and how to install it into
IBM Rational® Application Developer or IBM WebSphere Integration Developer so
that you can develop applications. For information on installing the sample
applications provided in the Branch Transformation Toolkit, see the deployment
procedures of the HTML Sample and Java ' Sample.

This document is for anyone who is installing IBM Branch Transformation Toolkit
for WebSphere Studio and describes how to install it into IBM Rational Application
Developer or IBM WebSphere Integration Developer.

Typographic conventions

The installation guide uses the following typographic conventions:

Convention Description of convention

Bold Used to indicate something you select or
click in the GUI

Italics Used for emphasis or to refer to another
document

Monospace font Used to indicate text that you type yourself

Oor screen messages

<> Used to enclose descriptions of variables
that you must type yourself or names of
tags within XML files as shown in the
following examples:

e <variable name>

* <tag name>

Keys are identified in this guide just as they appear on the keyboard (for example,
Enter, Tab, Ctrl).

Hardware and software requirements

This section lists the hardware and software requirements for the runtime and
development environments of IBM Branch Transformation Toolkit for WebSphere
Studio (Branch Transformation Toolkit) 5.2.

Hardware requirements

Hardware requirements for Server

Note: These memory and disk requirements listed below are for the IBM
WebSphere Application Server.

For Microsoft® Windows® 2003

+ Intel® Pentium® III processor at 1 GHz, or faster
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¢ Minimum 1 GB RAM; 2 GB recommended
* Minimum 1 GB of free disk space for installation (includes SDK)

For Linux® (Intel)

* Intel Pentium processor at 500 MHz, or faster

* Minimum 1 GB RAM; 2 GB recommended

* Minimum 1 GB of free disk space for installation (includes SDK)

For AIX

« IBM pSeries® or iSeries" system at 375 MHz, or faster

* Minimum 1 GB RAM; 2 GB recommended

* Minimum 1 GB of free disk space for installation (includes SDK)

For Solaris
* SPARC workstation at 440 MHz, or faster
* Minimum 512 MB RAM; 1 GB recommended

* Minimum 1 GB of free disk space for installation (includes SDK)

For additional software products, for example DB2®, IBM Communications Server
or WebSphere MQSeries®” Integrator, refer to the respective product documentation.

Hardware requirements for Client

For Windows XP

* Minimum 512 MB RAM

* Minimum 100 MB of free disk space for installation
* Minimum display 1024 x 768

For Linux (Intel)

* Minimum 512 MB RAM

e Minimum 100 MB of free disk space for installation
* Minimum display 1024 x 768

Hardware requirements for development environment

Note: These memory and disk requirements listed below are for the IBM Rational
Application Developer.

For Windows XP

¢ Intel Pentium III processor at 1 G MHz, or faster

e Minimum 1 GB RAM; 2 GB recommended

* Minimum 3.7 GB of free disk space for installation
* Minimum display 1024 x 768

For Linux (Intel)

¢ Intel Pentium III processor at 1 G MHz, or faster

e Minimum 1 GB RAM; 2 GB recommended

* Minimum 3.7 GB of free disk space for installation
* Minimum display 1024 x 768
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If the development environment requires additional software products, for example
DB2, IBM Communications Server or WebSphere MQSeries Integrator, refer to the
specific product documentation.

For the latest hardware requirements, refer to the documentation at
lhttp:/ /www.ibm.com /software/components).

Software requirements
Supported operating systems for development and runtime
* AIX® V5.2 with Recommended Maintenance Package 5200-03
* AIX V53
* Windows Server 2003, Enterprise and Standard
* Windows XP Professional with Service Pack 2 (Client and Development)
* Red Hat Enterprise Linux WS 3.0 Update 8 (Client and Development)
* Red Hat Enterprise Linux WS 4.0 Update 3 (Client and Development)
* Red Hat Enterprise Linux AS 3.0 Update 8
* Red Hat Enterprise Linux AS 4.0 Update 3
* Solaris 9 with the Recommended Patch Cluster of June 2005
* Solaris 10

Supported application servers

For Windows 2003, Solaris, Linux (Intel) and AIX

* WebSphere Application Server, V6.0.2

* WebSphere Application Server Network Deployment V6.0.2
* WebSphere Process Server V6.0.1 and V6.0.2

Supported development environment
 IBM Rational Application Developer V6.0.1
* WebSphere Integration Developer V6.0.1 and V6.0.2

Supported browsers
* Internet Explorer 6.0 SP1

Supported database

* DB2 UDB Enterprise Server Edition V8.2.7

* Oracle 10g

* Microsoft SQL Server 2000 Enterprise SP3 and Standard Edition

Optional software

¢ WebSphere MQ V6.0

* Communications Server for AIX V6.3

* Communications Server for Linux V6.0

* Communications Server for Windows V6.1.2
* WebSphere Portal for Multiplatforms V5.1

For the latest supported software, See |http:/ /www.ibm.com/software/components|
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Additional requirements

Depending on the framework services you use, you may require other hardware
and software to support financial devices. The following additional requirements
apply to the type of workstation (client, server, or development) that accesses the
financial device.

Table 1. Additional financial devices requirements

Framework component Additional requirements

J/eXtensions for Financial Services Any financial printer, magnetic stripe
reader/encoder, or check reader with a
device service that is compliant with the
J/XFS specification

eXtensions for Financial Services Any financial printer, magnetic stripe
reader/encoder, or check reader with a
device service that is compliant with the
J/XFS specification

Setting up a Branch Transformation Toolkit development environment
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In this procedure, you will set up a development workstation so that you can
develop applications based on IBM Branch Transformation Toolkit 5.2 for
WebSphere Studio. Note that the physical machine must comply with the
requirements listed in the Hardware and software requirements section, including
having IBM WebSphere Integration Developer or IBM Rational Application
Developer.

Note: The following procedure describes how to install the Branch Transformation
Toolkit on top of IBM Rational Application Developer or IBM WebSphere
Integration Developer. Each functional unit is contained in its own JAR file
to provide greater flexibility both in the development environment and in
runtime. Consider reviewing functional units, packages, and dependencies
to decide which functional units you need to develop your application.
Note, however, that you can add or remove functional units at any time
provided you account for their corequisite functional units (functional units
that must also exist on the system at the same time).

Installation package structure

The Branch Transformation Toolkit installation package mainly contains two
groups of components - components for the development environment and
components for the runtime environment.

Development environment

For the development environment, Branch Transformation Toolkit supports IBM
Rational Application Developer 6.0.1 and IBM WebSphere Integration Developer
6.0.2.

For the development environment, there are two sets of plug-ins including
different files:

* Plug-ins for IBM Rational Application Developer 6.0.1

These plug-ins include components that have dependencies on features provided
by IBM Rational Application Developer 6.0.1.

* Plug-ins for IBM WebSphere Integration Developer 6.0.2
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These plug-ins include components that have dependencies on features provided
by IBM WebSphere Integration Developer 6.0.2, such as plug-ins for the Business
Process BTT Wizard.

If you have IBM WebSphere Integration Developer 6.0.2 installed on your system,
the toolkit installation wizard will take IBM WebSphere Integration Developer as
your development environment, regardless of whether you have IBM Rational
Application Developer installed as well. After the installation wizard decides that
IBM WebSphere Integration Developer is your development environment, it copies
the plug-ins for IBM WebSphere Integration Developer to the wstools/eclipse/
plugins directory of your IBM WebSphere Integration Developer automatically
during the installation.

If you have IBM Rational Application Developer 6.0.1 installed on your system, the
toolkit installation wizard will take IBM Rational Application Developer as your
development environment. After the installation wizard decides that IBM Rational
Application Developer is your development environment, it copies the plug-ins for
IBM Rational Application Developer 6.0.1 to the eclipse/plugins directory of your
IBM Rational Application Developer 6.0.1 automatically during the installation.

If neither IBM Rational Application Developer 6.0.1 nor IBM WebSphere
Integration Developer 6.0.2 is installed on your system, you will need to copy the
plug-ins to the $D(RAD)/eclipse/plugins or $D(WID)/wstools/eclipse/plugins
directory manually after you have IBM Rational Application Developer or IBM
WebSphere Integration Developer installed later. Plug-ins for IBM Rational
Application Developer or IBM WebSphere Integration Developer can be found in
the <tooklit_root>/plugins directory.

Runtime environment

For the runtime environment, Branch Transformation Toolkit supports WebSphere
Application Server 6.0.2 and WebSphere Process Server 6.0.2.

Installing the Branch Transformation Toolkit on a development
workstation
To set up the development workstation, do the following:

1. According to your business needs, install IBM Rational Application Developer
or IBM WebSphere Integration Developer.

2. Insert the Branch Transformation Toolkit CD into CD-ROM and browse the CD.
If you want to install Branch Transformation Toolkit for windows, run
C993IML.exe in the Windows platform. If you want to install Branch
Transformation Toolkit for Linux, run C993]JML.bin in the Linux platform. This
starts the Installation Wizard for Branch Transformation Toolkit.

3. During the installation, the Installation Wizard detects if any version of Branch
Transformation Toolkit is already installed on your system. Branch
Transformation Toolkit version 5.2 can coexist with that of version 4.3, 5.0 or
5.1. If you already have version 5.2 installed, the Installation Wizard will
display a warning message showing that you already have version 5.2 installed.
If you continue with the installation, your previous installation of version 5.2
will be overridden.

4. The Installation Wizard also checks the IBM Rational Application Developer
you installed. If you have installed IBM Rational Application Developer, the
Install Wizard will install toolkit components designed for IBM Rational
Application Developer and those for WebSphere Application Server. If you
have IBM WebSphere Integration Developer installed, the Installation Wizard
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will install toolkit components designed for IBM WebSphere Integration
Developer, and those for WebSphere Application Server.

The Branch Transformation Toolkit installation program creates the following
set of directories on the target machine.

Table 2. Directories created by installation

Directory name Description of contents

dbtools Scripts to manage database tables for the
CHA component

desktop Desktop DTD file

doc The Branch Transformation Toolkit

documentation plug-ins to IBM WebSphere
Integration Developer and IBM Rational
Application Developer.

plugins * Visual beans plug-in to IBM WebSphere
Integration Developer

* Eclipse Modeling Framework (EMF)
plug-in

* Graphical Builder plug-in

* Struts Tools BTT Extensions plug-in

* CHA Editor plug-in

* Format Editor plug-in

* Business Process BTT Wizard plug-in to
IBM WebSphere Integration Developer

* Migration Tool plug-in
* Definition File Merging Tool plug-in

ear EAR file to provide the infrastructure for the
CHA component of the toolkit. You can use
the EAR to build applications on the Branch
Transformation Toolkit

jars The Branch Transformation Toolkit code
separated into various JARs according to the
functional unit to which the code belongs. A
solution built on the Branch Transformation
Toolkit can use the JARs for the functional
units that it is using. See Functional units,
packages, and dependencies for a listing of
the JARs and their contents and corequisites

samples EAR files to run the sample applications
provided by the Branch Transformation
Toolkit in the IBM Rational Application
Developer workbench. This directory also
contains the source code of the samples.

services Runtime files that are needed by some of the
services of the framework

source Source code of selected Branch
Transformation Toolkit components to
provide a better understanding of the
functional units. This helps in tasks such as
extending the framework and reduces the
development cycle. The source code must
not be modified

javadoc
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5. Start IBM Rational Application Developer or IBM WebSphere Integration
Developer.

6. Set some preferences before you import Branch Transformation Toolkit Java
source:

* To work with complex projects, you should use the source folders as source
containers instead of creating packages directly inside the project. To do this,
you create source folders as children of the project and create your packages
inside these source folders. To automate this, go to Window > Preferences.
Expand the Java node and select the New Project node. Enable the Folders
check box.

* To develop with the Branch Transformation Toolkit, add the framework
functional units (the JAR files containing the classes) to the application
classpath. You can use any approach to do this but you must account for the
class loader policies.

A recommended approach is to add an overall classpath variable named BTT
to point to the root directory of the Branch Transformation Toolkit
installation. To do this:
a. Go to Window » Preferences.
b. Expand the Java node and select Build Path.
c. Expand the Build Path node and select Classpath Variables.
d. Click New and in the Name entry field, type the following:
BTT

e. In the Path entry field, type the path to where the Branch Transformation
Toolkit was installed.

f. Click OK.

In the same way, add another classpath variable named, for example,
BTT_EXTERNAL to point to the external dependencies. To make the external
classpath variable work, all the required external JARs must be in the
directory to which this variable points. The overall classpath variables make
it easier for you to select the Branch Transformation Toolkit JAR files for
your Java project.

Another approach is to define a classpath variable for each functional unit
available in the product. Each classpath variable points to the concrete JAR
associated with the functional unit (see the tables in Functional units,
packages, and dependencies).

The remainder of this procedure and all the other procedures assume that
you are using the recommended approach.

7. Create a Java project for application. To create the project:
a. Select File > New - Project.

b. Select Java in the left panel and then select Java Project in the right panel.
Click Next.

c. Type the name of the project, such as HomeBanking, and click Finish.

8. When deploying an application, you must embed Branch Transformation
Toolkit functional units, along with the required application resources, inside
the J2EE EAR file. The Branch Transformation Toolkit uses functional units to
provide a coherent structure of JAR files that you use to build an application.
The JARs in the functional units contain the required set of classes for a given
execution environment.

To make the functional units available to your project, you can either add the
compiled JARs to the project’s classpath or you can import the JARs into the

Branch Transformation Toolkit installation guide 7



8

workspace. You can choose the second option if you want to embed the JARs
and resources into your application when, for example, it is self-contained and
independently deployed.

For either option, you only add or import the JARs and their corequisites
needed for the application to optimize the deployment and distribution of the
application. Consult Functional units, packages, and dependencies to obtain
these corequisites.

If you are unsure of the actual dependencies among the JARs, add the ones
that you are not sure about. You can always remove unneeded jars later. For
examples of the JARs that you should select, browse the list of jars used by the
sample applications shipped in the <Toolkit root>/samples folder. If you open,
for example, the BTTHtmlSampleWeb.war file that is inside the
BBTTHtmlSample.ear file, you can see that the following functional units have
been used to build the application:

¢ BTTBase(bttbase.jar)

* BTTInvoker(bttinvoker.jar)

* BTTJavaClient(bttjavaclient.jar)

¢ BTTServerBean(bttsvrbean.jar)

* BTTSessionManagement(bttsm.jar)

* BTTStrutsExtension(bttstruts.jar)

¢ BTTHTMLSampleE]B(BTTHTMLSampleE]B jar)

To add the required JARs to the project’s classpath:

a. Right-click the project and select Properties.

b. Select JavaBuildPath and then select the Libraries tab.

C. Select Add Variable and, in the New Variable Classpath Entry window,
select the classpath variable ( BTT) and click Extend.

d. In the Variable Extension window, expand the jars directory and select the
BTT JAR that you want to add to your project. Click OK.

e. If the JAR you have just added to your project has source code shipped
with the Branch Transformation Toolkit (see Functional units, packages, and
dependencies), you may want to attach the source code to the JAR to enable
source-level stepping and browsing of classes contained in the binary JAR
file. To do this:

1) Click Attach Source.

2) In the Attachments For BTT/jars/<JAR name>jar window, click the
Variable button next to the Archive variable path text field.

3) Select the classpath variable (BTT) and click OK.
4) Click Extension.
5) In the JAR/ZIP File Selection window, open the source directory and

double click the ZIP file containing the source code corresponding to the
JAR file you added to your project. Click OK.

f. Repeat this procedure for each JAR file that you want to add. Keep in mind
the dependencies that a JAR or functional unit may have. Consult Functionail
[units, packages, and dependencies|to obtain these dependencies.

Once you have installed the Branch Transformation Toolkit in IBM Rational
Application Developer or IBM WebSphere Integration Developer, you can start
developing Branch Transformation Toolkit-based solutions. For a high level
overview of the development process and where to get information, see the
Creating an application documentation. For examples of Branch Transformation
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Toolkit-based applications, including how to install and run them on the various
supported platforms, see the Java Sample Application and HTML Sample
Application documentation.

Setting up the CHA Editor

The CHA Editor for the Branch Transformation Toolkit is a plug-in. CHA Editor
configuration files (or CHA Editor files) allows you to create CHA elements with a
graphical user interface.

Prerequisites to use the CHA Editor:

* If you had installed the toolkit before you installed the IBM Rational Application
Developer or IBM WebSphere Integration Developer, you need to copy the
following plug-in files to the wstools\eclipse\plugins\ folder of your
WebSphere Studio installation folder:

— com.ibm.btt.tools.common_5.2.0

— com.ibm.btt.tools.chaeditor.model.emf 5.2.0
— com.ibm.btt.tools.chaeditor_5.2.0

To create a CHA Editor file, follow these steps:

1.

A A

10.

Start IBM Rational Application Developer or IBM WebSphere Integration
Developer.

Create a simple project to contain the CHA Editor files.
From the File menu, select File > New > Other.
In the dialog, select IBM Branch Transformation Toolkit in the left panel.

In the right panel, select CHA Editor file. This starts the CHA Editor
Configuration Wizard.

Select the project to contain the CHA Editor’s files. Usually this is the project
file for the application you are creating.

In the file name field, type the name of the editor’s configuration file. The file
must have the .chae extension.

Click Finish.
From the menu bar, select Window » Show view > Other.

In the window that pops up, expand IBM Branch Transformation Toolkit,
and select the CHA Editor views that you want to show.

The wizard then creates the configuration file and the dsedata.xml, dsetype.xml,
and dsectxt.xml files in the project folder. It then launches the CHA Editor.

Setting up the Format Editor

The Format Editor for the Branch Transformation Toolkit is a WebSphere Studio
plug-in. Format Editor configuration files (or Format Editor files) help you create
formatters with a graphical user interface.

Prerequisites to use the Format Editor:

¢ If you had installed the toolkit before you installed the IBM Rational Application
Developer or IBM WebSphere Integration Developer, you need to copy the

following plug-in files to the wstools\eclipse\plugins\ folder of your

WebSphere Studio installation folder:
— com.ibm.btt.tools.common_5.2.0
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— com.ibm.btt.tools.fmteditor_5.2.0
— com.ibm.btt.tools.chaeditor_5.2.0

To create a Format Editor file, follow these steps:

1. Start IBM Rational Application Developer or IBM WebSphere Integration
Developer.

Create a simple project to contain the Format Editor files.
From the File menu, select File > New > Other.
In the dialog, select IBM Branch Transformation Toolkit in the left panel.

o k0D

In the right panel, select Format Editor file. This starts the Format Editor
Configuration Wizard.

6. Select the project to contain the Format Editor’s files. Usually this is the
project file for the application you are creating.

7. In the file name field, type the name of the editor’s configuration file. The file
must have the .fmte extension.

Note: Each Format Editor file works with a CHA Editor file to provide the
formatters for the CHA elements described in the CHA Editor file. You
should define the CHA Editor file name in the configuration of the
Format Editor file to ensure they can work together.

8. Click Finish.
9. From the menu bar, select Window » Show view > Other.

10. In the window that pops up, expand IBM Branch Transformation Toolkit,
and select the Format Editor views that you want to show.

The wizard then creates the configuration file and the dsefmt.xml file in the project
folder. It then launches the Format Editor.

Setting up the Business Process BTT Editor

The Business Process BTT Editor for the Branch Transformation Toolkit is a
WebSphere Studio plug-in. The Business Process BTT Editor provides a graphical
user interface (GUI) to help you extend your business processes for taking
advantage of the BTT Abstract Layer.

Prerequisites to use the Business Process BTT Editor:

* If you had installed the toolkit before you installed the IBM WebSphere
Integration Developer, you need to copy the following plug-in files to the
eclipse\wstools\plugins\ folder of your WebSphere Studio installation folder:

— com.ibm.btt.tools.bpel.ui_5.2.0
— com.ibm.btt.tools.bpel.model_5.2.0

Setting up the Struts Tools BTT Extensions
The Struts Tools BTT Extensions for the Branch Transformation Toolkit is a
WebSphere Studio plug-in. The Struts Tools BTT Extensions provides a graphical

and easier way to work with toolkit extended Struts configuration files.

Prerequisites to use the Struts Tools BTT Extensions:
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 If you had installed the toolkit before you installed the IBM Rational Application
Developer or IBM WebSphere Integration Developer, you need to copy the
following plug-in files to the wstools\eclipse\plugins\ folder of your
WebSphere Studio installation folder:

— com.ibm.btt.tools.common_5.2.0
— com.ibm.btt.tools.struts_5.2.0
— com.ibm.btt.tools.webdiagrameditor_5.2.0

Setting up the Graphical Builder

The Graphical Builder for the Branch Transformation Toolkit is a WebSphere Studio
plug-in. The Graphical Builder integrates all developing tools and provides a new
way of visualization, integrated development, and seamless deployment technique
that applies to the full lifecycle of your application development.

Prerequisites to use the Graphical Builder:

 If you had installed the toolkit before you installed the IBM Rational Application
Developer or IBM WebSphere Integration Developer, you need to copy the
following plug-in files to the wstools\eclipse\plugins\ folder of your
WebSphere Studio installation folder:
— com.ibm.btt.tools.bpel.model_5.2.0

com.ibm.btt.tools.bpel.ui_5.2.0

— com.ibm.btt.tools.chaeditor.model.emf_5.2.0
— com.ibm.btt.tools.chaeditor_5.2.0

— com.ibm.btt.tools.common_5.2.0

— com.ibm.btt.tools.fmteditormodel.emf_5.2.0
— com.ibm.btt.tools.fmteditor_5.2.0

— com.ibm.btt.tools.gw.model.emf_5.2.0

— com.ibm.btt.tools.gw_5.2.0

— com.ibm.btt.tools.migration_5.2.0

— com.ibm.btt.tools.selfdefine 5.2.0

— com.ibm.btt.tools.struts_5.2.0

— com.ibm.btt.tools.webdiagrameditor_5.2.0

— com.ibm.dse.guibeans_5.2.0
Setting up the migration tool

The migration tool is an IBM Rational Application Developer plug-in that helps
you migrate your toolkit applications to version 5.2 applications.

Prerequisites to use the migration tool:

 If you had installed the toolkit before you installed the IBM Rational Application
Developer or IBM WebSphere Integration Developer, you need to copy the
following plug-in files to the wstools\eclipse\plugins\ folder of your
WebSphere Studio installation folder:

com.ibm.btt.tools.common_5.2.0

com.ibm.btt.tools.chaeditor.model.emf_5.2.0
com.ibm.btt.tools.chaeditor_5.2.0
— com.ibm.btt.tools.fmteditor_5.2.0
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— com.ibm.btt.tools.fmteditor.model.emf 5.2.0
— com.ibm.btt.tools.struts_5.2.0

— com.ibm.btt.tools.webdiagrameditor_5.2.0
— com.ibm.btt.tools.bpel.model_5.2.0

— com.ibm.btt.tools.bpel.ui_5.2.0

— com.ibm.btt.tools.selfdefine_5.2.0

— com.ibm.btt.tools.bpel.model_5.2.0

— com.ibm.btt.tools.bpel.ui_5.2.0

— com.ibm.dse.guibeans_5.2.0

— com.ibm.btt.tools.gw_5.2.0

— com.ibm.btt.tools.gw.model.emf_5.2.0

— com.ibm.btt.tools.migration_5.2.0

Installing toolkit applications on a runtime platform

Installing Branch Transformation Toolkit applications on a runtime platform
consists of deploying EAR files onto WebSphere Application Server. You can do the
packaging using IBM WebSphere Integration Developer or IBM Rational
Application Developer, or using the Application Assembly Tool in WebSphere
Application Server.

The Branch Transformation Toolkit provides four sample applications that you can
immediately deploy on WebSphere Application Server after you make a few
customizations to adapt the sample applications to your particular requirements.
See the deployment section of Java Sample Application and HTML Sample
Application documentation for this information. The sample application
documentation will also provide you with guidance on deploying your own
applications.

Functional units, packages, and dependencies

This section identifies the external dependencies and framework corequisites for
each functional unit. You must load these dependencies and corequisites to have a
clean development environment. In addition to the components provided by the
required features for the Branch Transformation Toolkit, you may need other
external packages. See Obtaining missing prerequisites for a list of these packages.

The tables below include a brief description of the functional unit, whether it also
has source code, and the functional unit’s ZIP file. Each row shows the direct
framework corequisites and the corequisites of these corequisites.

Table 3. External dependencies and corequisites for functional units-JAR files

Functional unit or

JAR Name component Source ZIP name External dependency Corequisite JAR
bttbase Basic framework component | BTTBase J2EE, Activity Session , ras.jar dseb
BTTCHAE]B CHA BTTCHA J2EE bttbase
bttevent BTT Event BTTEvent J2EE dseb, bttbase,
bttjavaclient, bttsm,
bttinvoker, dsesym
bttinvoker EJB invocation framework BTTInvoker J2EE, webcontainerjar, bttbase, bttevent,
ivjejb35.jar, websphere.jar, Work | bttjavaclient, bttsm, dseb,
Area, wsdl4jjar, wsatlib jar dsesym
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Table 3. External dependencies and corequisites for functional units-JAR files (continued)

Functional unit or

JAR Name component Source ZIP name External dependency Corequisite JAR
bttjavaclient Java client support BTTJavaClient J2EE bttbase, bttinvoker,
bttsm, dseb
bttjdbjsvec Jdbc Table Service BTTJdbcJournalService J2EE, servletevent.jar, ivjejb35jar, | bttbase, bttfmt,
runtime.jar bttjdbtsvc, bttsvcinfra
bttjdbtsvc Jdbc Journal Service BTT]JdbcTableService utils jar bttbase, bttfmt,
bttsvcinfra
bttopstepadaptor Operation step adaptor BTTOpStepAdaptor J2EE bttbase, bttevent, bttsm
bttsm session management BTTSessionManagement | J2EE, activitySession.jar bttbase
bttstruts HTML client in BTT5.1 BTTStrutsExtension Apache Struts 1.1, J2EE, WSDL bttbase, bttinvoker,
bttsm, dseb
bttstrutsportal Fully Portal support BTTStrutsPortal Apache Struts 1.1, Portal Server | bttbase, bttevent,
5.1, J2EE, WSDL, dynacache.jar bttinvoker, bttsm,
bttstruts
bttsvrbean Single Action EJB BTTServerBean Work Area bttbase, bttfmt,
bttsvcinfra
bttsvrflow BTT Business Process BTTServerFlow Work Area, QName, ras.jar, Web | bttbase, bttfmt,
Services Invocation Framework, bttsvcinfra
WSDL, bpe jar
dseb Basic framework component | DSEBase J2EE Java Servlet API (server
only)
dsecsm Client/Server mechanism DSEClientServer SSLight jar dsecss, dsesym, dseb
Mechanism
dsecss Client/Server support DSEClientServer Support |J/XFS dseb
dsed Desktop DSEDesktop Java Help, J2EE dseflp, dsegb, dseb
dseflp Flow processor DSEFlowProcessor dseb
dseflpeclt Flow Processor extensions DSEFlowProcessor dseb, dsed, dsegb, dseflp
(client) ExtClient
dsegb GUI Beans DSEGuiBeans SWT dseb
dsejseib JSSE enabler DSEJsseEnablerForlbm Java Secure Sockets Extension dseb, dsecss
dsejxbsvc JXFS service base N/A J/XFS dseb
dsejxcsve JXES Check Reader N/A J/XFS dsejxbsvc, dseb
dsejxpsve JXFS Print service N/A J/XFS dsejxbsvc, dseb
dsejxmsvc JXES MSR/E service N/A J/XFS dsejxbsvc, dseb
dsesci Common infrastructure for N/A dseb
services
dsesym System Management N/A
dsetde Typed data extensions DSETypedData dseb
Extensions
dsewojxdsi J/XFS device service N/A J/XFS dsewossve, dseb
infrastructure (WOSA based)
dsewomijxds J/XFS MSR/E device service | N/A J/XFS dsewojxdsi, dseb
(WOSA based)
dsewopjxds J/XFS printer device service |N/A J/XFS dsewojxdsi, dsewossvc,
(WOSA based) dseb
dsewossvc WOSA support N/A dseb
BTTServicesInfra_51 BTT V5.1 Service Infra BTTServicesInfra J2EE Web Services Invocation bttbase

Framework, WSDL, QName,
Xerces Java Parser,
commons-logging-api.jar, Xalan,
SOAP, Java Mail, activation.jar

Table 4. External dependencies and corequisites for functional units-RAR files

RAR name Functional unit or component Source ZIP name | External dependency Corequisite JAR

dummysnalu0 | BTTDummySnaLu0OConnector N/A J2EE JCA

snalu0 DSELuOConnector N/A Communication Server J2EE JCA
DSELu0OConnector]caPlugin WSIF
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Table 4. External dependencies and corequisites for functional units-RAR files (continued)

RAR name

Functional unit or component

Source ZIP name

External dependency

Corequisite JAR

snalu62

BTTLu62Connector
BTTLu62Connector]caPlugin

N/A

Communication Server J2EE JCA
WSIF

The following samples are only provided in source code contained in ZIP files:

Table 5. Source ZIP files and dependencies for samples

Sample Source ZIP name Dependency
Sample of how to use the WOSA DSEWosaSample dseb, dsewossvc
service

Sample of how to use the BTTSampleServices bttbase, bttCHA

BTTServices

The following table lists the sample EAR files, their source

and any corequisites.

Table 6. Source ZIP and EAR files and external and corequisites for the Samples

or compiled code file,

External
Sample Source ZIP and EAR files Corequisite Corequisite JAR
HTML Sample Application BTTHTMLSample.ear bttbase, bttinvoker,
bttfmt, bttjavaclient,
bttjdbjsvc, bttjdbtsve,
bttsm, bttstruts,
bttsvrbean, bttsvcinfra
HTML Sample BP Application BTTHTMLSampleBPEAR.ear bttbase, BITCHAE]B,
bttfmt, BTTFormatterE]B,
bttjdbjsvc, bttjdbtsvc,
bttsvrbean, bttsvrflow,
bttsvcinfra, sn0dummy
Java Sample Application- BTTCHAFMTServer.ear, bttbase, bttfmt, bttjdbjsvc,
CHAFMTSeperated BTTJavaSample.ear bttjdbtsvc, bttsvcinfra,
bttsvrbean, dsecsm,
dsecss, dsed, dseflp,
dseflpeclt, dsegb,
dsejxpsvc, dsesci,
dsesym, dsetde,
sn0dummy
Java Sample Application- BTTCHAEAR .ear,
MultiCHA BTTJavaSample.ear
Java Sample Application- BTTJavaSample.ear
StandAlone
Portal HTML Sample Application | BITPortalHTMLSample.ear bttbase, bttfmt, bttjdbjsvc,
bttjdbtsvc, bttinvoker,
bttjavaclient, bttsvrbean,
bttsm, bttstruts,
bttsvcinfra
SampleServiceApplication BTTSampleService.ear bttbase, BTTCHA
DSEWosaSample DSEWosaSample.zip WOSA /XFS dseb, dsewossvc
manager and the
financial device
SPI drivers
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Table 6. Source ZIP and EAR files and external and corequisites for the Samples (continued)

Sample

Source ZIP and EAR files

External

Corequisite Corequisite JAR

JCASNASampleCode

JCASNASampleCode.zip

BTTHTMLChannelSampleCode

BTTHTMLChannelSampleCode.zip |J2EE

btthtmlchannel, bttbase,
bttjavaclient, bttinvoker

BTTOpStepAdaptorSampleCode

BTTOpStepAdaptorSampleCode.zip| J2EE , struts.jar

bttsm, bttsvrbean,
bttinvoker

bttopstepadaptor, bttbase,

The following table lists the packages included in the product and the JAR, RAR or
ZIP files that contain them. Note that some Java packages are in more than one
JAR to optimize the contents of the JAR files.

Table 7. JAR, RAR or ZIP files for packages

Package name

JAR/RAR/ZIP name

com.ibm.btt.automaton

btthtmlchannel jar, BTTHTMLChannel.zip

com.ibm.btt.automaton.ext

btthtmlchannel.jar, BTTHTMLChannel.zip

com.ibm.btt.automaton.html

btthtmlchannel jar, BTTHTMLChannel.zip

com.ibm.btt.base

bttbase.jar, BTTBase.zip, bttopstepadaptorjar,
BTTOpStepAdaptor.zip

com.ibm.btt.base.types

bttbase jar, BTTBase.zip

com.ibm.btt.base.types.ext

bttbase.jar, BTTBase.zip

com.ibm.btt.cha.ejb

bttbase.jar, BTTBase.zip, BITCHAE]B jar, BITCHA.zip

com.ibm.btt.clientserver

bttjavaclient.jar, BTTJavaClient.zip

com.ibm.btt.cs.html

btthtmlchannel jar, BTTHTMLChannel.zip

com.ibm.btt.cs.html.util

btthtmlchannel.jar, BTTHTMLChannel.zip

com.ibm.btt.cs.invoker.base

bttinvokerjar, BTTInvoker.zip

com.ibm.btt.cs.invoker.base.xml

bttinvoker.jar, BTTInvoker.zip

com.ibm.btt.cs.invoker.cache

bttinvokerjar, BTTInvoker.zip

com.ibm.btt.cs java

bttjavaclient.jar, BTTJavaClient.zip

com.ibm.btt.cs.servlet

bttjavaclient.jar, BTTJavaClient.zip

com.ibm.btt.cs.sessionpropagation

bttinvokerjar, BTTInvoker.zi

com.ibm.btt.event

bttevent.jar, BTTEvent.zip

com.ibm.btt.formatter.client

bttbase.jar, BTTBase.zip

com.ibm.btt.gui.jsptags

btthtmlchannel.jar, BTTHTMLChannel.zip

com.ibm.btt.samples.business.sna.lu0

dummysnalu0.rar

com.ibm.btt.samples.business.sna.lu0.exception

dummysnalu0.rar

com.ibm.btt.samples.business.sna.lu0.host

dummysnalu0.rar

com.ibm.btt.samples.business.sna.lu0.host.event

dummysnalu0.rar

com.ibm.btt.samples.business.sna.lu0.resource

dummysnalu0.rar

com.ibm.btt.samples.business.sna.lu0.services

dummysnalu0.rar

com.ibm.btt.samples.business.sna.util

dummysnalu0.rar

com.ibm.btt.server.bean

bttsvrbean.jar, BTTServerBean.zip
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Table 7. JAR, RAR or ZIP files for packages (continued)

Package name

JAR/RAR/ZIP name

com.ibm.btt.server.flow

bttsvrflow.jar, BTTServerFlow.zip

com.ibm.btt.services

bttsvcinfra.jar, BTTServicesInfra.zip

com.ibm.btt.services.jdbc bttjdbtsvc.jar
com.ibm.btt.services.jdbc journal bttjdbjsvc.jar
com.ibm.btt.services.jdbc.tablemapping bttjdbtsvc.jar

com.ibm.btt.sm

bttsm.jar, BTTSessionManagement.zip

com.ibm.btt.sm.as

bttsm.jar, BT TSessionManagement.zip

com.ibm.btt.struts

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.actions

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.base

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.config

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.exception

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.plugins

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.session

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.taglib.html

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.struts.utils

bttstruts.jar, BTTStrutsExtension.zip

com.ibm.btt.strutsportal.actions

bttstrutsportal jar, BTTStrutsPortal.zip

com.ibm.btt.strutsportal.base

bttstrutsportal jar, BTTStrutsPortal.zip

com.ibm.btt.strutsportal.taglib.html

bttstrutsportal.jar, BTTStrutsPortal.zip

com.ibm.btt.tools.migration bttmigration.jar
com.ibm.btt.tools.migration.btttags bttmigration.jar
com.ibm.btt.tools.migration.chaformat bttmigration.jar
com.ibm.btt.tools.migration.dialog bttmigration.jar
com.ibm.btt.tools.migration.dseini bttmigration.jar
com.ibm.btt.tools.migration.fileimport bttmigration.jar
com.ibm.btt.tools.migration.gb bttmigration.jar
com.ibm.btt.tools.migration.generator.bp bttmigration.jar
com.ibm.btt.tools.migration.generator.ejb bttmigration.jar
com.ibm.btt.tools.migration.generator.invoker bttmigration.jar
com.ibm.btt.tools.migration.generator.invoker.gen bttmigration.jar
com.ibm.btt.tools.migration.generator.opstep bttmigration.jar
com.ibm.btt.tools.migration.operation bttmigration.jar
com.ibm.btt.tools.migration.popup.actions bttmigration.jar
com.ibm.btt.tools.migration.processor bttmigration.jar
com.ibm.btt.tools.migration.screenflow.module bttmigration.jar
com.ibm.btt.tools.migration.selfdefine bttmigration.jar
com.ibm.btt.tools.migration.util bttmigration.jar
com.ibm.btt.tools.migration.wizard bttmigration.jar
com.ibm.connector2.sna.lu0 snalu0.rar

com.ibm.connector2.sna.lu0.exception snalu0.rar
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Table 7. JAR, RAR or ZIP files for packages (continued)

Package name

JAR/RAR/ZIP name

com.ibm.connector2.sna.lu0.host snalu0.rar
com.ibm.connector2.sna.lu0.host. event snalu0.rar
com.ibm.connector2.sna.lu0.resource snalu0.rar
com.ibm.connector2.sna.lu0.tools snalu0.rar
com.ibm.connector2.sna.lu0.tools.resources snalu0.rar
com.ibm.connector2.sna.lu0.util snalu0.rar

com.ibm.connector2.sna.lu62

snalu62.rar

com.ibm.connector2.sna.lu62.exception

snalu62.rar

com.ibm.connector2.sna.lu62.host

snalu62.rar

com.ibm.connector2.sna.lu62.host. event

snalu62.rar

com.ibm.connector2.sna.lu62.resource

snalu62.rar

com.ibm.connector2.sna.lu62.util

snalu62.rar

com.ibm.connector2.sna.services

snalu62.rar

com.ibm.connector2.sna.util

snalu62.rar snalu0.rar

com.ibm.dse.automaton

dseflp.jar, DSEFlowprocessor.zip

com.ibm.dse.automaton.ext

dseflpe. jar DSEFlowProcessorExtensions.zip

com.ibm.dse.automaton.ext.client

dseflpeclt.jar, DSEFlowProcessorExtClient.zip

com.ibm.dse.base

dseb.jar, DSEBase.zip

com.ibm.dse.base.types

dseb.jar, DSEBase.zip

com.ibm.dse.base.types.ext

dsetde jar, DSETypedDataExtensions.zip

com.ibm.dse.clientserver

dseb.jar, DSEBase.zip dsepsi jar,
DSEPresentationServerInfra.zip

com.ibm.dse.cs.servlet

dsecss.jar, DSEClientServerSupport.zip dsecsm.jar,
DSEClientServerMechanism.zip dseb.jar, DSEBase.zip

com.ibm.dse.desktop

dsed.jar, DSEDesktop.zip

com.ibm.dse.gui

dsegb.jar, DSEGuiBeans.zip

com.ibm.dse jxfsds.wosamsd dsewomjxds.jar
com.ibm.dse jxfsds. wosaptr dsewopjxds.jar
com.ibm.dse.services dsesci.jar

com.ibm.dse.services.jxfs

dsejxbsvc.jar

com.ibm.dse.services.jxfs.chk

dsejxcsve.jar

com.ibm.dse.services jxfs.msd dsejxmsvc.jar
com.ibm.dse.services.jxfs.ptr dsejxpsvc.jar
com.ibm.dse.services.wosa dsewossvc.jar
com.ibm.dse.sysmngment dsesym jar
com.ibm.dse.wosabean dsewojxdsi.jar
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Where to find the missing prerequisites

18

Use the following table to locate and obtain any missing prerequisites. Some of
them can be found in other JAR or ZIP files.

Table 8. Locations for prerequisites

Prerequisite Resource name How to get them

IBM DB2 db2java.zip Available from IBM DB2
Universal Database™

Oracle classes12.zip Available from Oracle

SQL Server 2000

msutil jar mssqlserver.jar
msbase.jar

Available from Microsoft
SQL Server 2000

portlet-api jar strutsfilters.jar
StrutsUpdateForPortal jar

J2EE Connector Architecture |j2ee.jar Available in WebSphere
API Application Server
MQSeries MQSeries.jar Available from MQSeries
Xerces Java Parser xerces.jar Available in WebSphere
Application Server
JavaHelp jh.jar Available in WebSphere
Application Server
SOAP soap.jar Available in WebSphere
Application Server
EJB Container ejbcontainer.jar Available in WebSphere
Application Server
RAS/Trace Subsystem ras.jar Available in WebSphere
Application Server
Runtime Utilities utils.jar Available in WebSphere
Application Server
External WebSphere APIs websphere.jar Available in WebSphere
Application Server
Xalan xalan.jar Available in WebSphere
Application Server
EJB base classes ivjejb35.jar Available in WebSphere
Application Server
Data converters vaprt.jar Available in WebSphere
Application Server
QName XML Extension gname.jar Available in WebSphere
Application Server
WSDL wsdl4j.jar Available in WebSphere
Application Server
Portal PortalStruts.jar Available in WebSphere
PortalStrutsBase.jar Portal Server. Version 5.1
PortalStrutsCommon jar required
PortalStrutsTags jar

J2EE Connector Architecture
Default Connection Manager

ccf2 jar

Available in WebSphere
Application Server

Web Services Invocation
Framework

wsif jar wsif-j2c.jar wsatlib.jar
wsif-compat.jar
wsif-compatb.jar

Available in WebSphere
Application Server
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Table 8. Locations for prerequisites (continued)

Prerequisite Resource name How to get them

Work Area acwa.jar distexcep.jar Available in WebSphere
Business Integration Server
Foundition

BP Support bpe.jar Available in WebSphere
Business Integration Server
Foundition

Activity Session activitySession.jar Available in WebSphere

Application Server

Common Log

commons-logging-api.jar

Available in WebSphere
Application Server

Eclipse

compatibilityjar console jar
core.jar defaultAdaptor.jar
eclipseAdaptor.jar jface jar
osgi.jar resolver.jar
runtime jar services.jar
servletjar swtjar uijar

util jar workbench jar
xercesImpl.jar xml-apis.jar
xmlParserAPIs jar

Available in Eclipse, version
3.0.0 required.

JavaBeans' " Activation

activation.jar

Available in WebSphere

Framework Application Server

JavaMail mail jar Available in WebSphere
Application Server

Runtime runtime jar Available in WebSphere

Application Server
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM China Software Development Lab

Diamond Building, ZhongGuanCun Software Park, Dongbeiwang West Road No.8,
ShangDi, Haidian District, Beijing 100094 P. R. China

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples may include
the names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.
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Trademarks and service marks

The following terms are trademarks of International Business Machines
Corporation in the United States, or other countries, or both:

AIX MQSeries

AIX 5L pSeries

DB2 S/390 Parallel Enterprise Server
DB2 Universal Database WebSphere

eServer z/0S

IBM zSeries

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.
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